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 »محصولات مرتبط چاپ شده  «
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 ) www.iranestekhdam.ir( است. شده نوشته  نادرستاي در گزینه .......... معناي واژه  -1

 گري) ) (تجلیل: بزرگداشت)، (تجلی: جلوه 2  ) (محاسن: ریش)، (خفایا: پنهان)1

 جسارت: دلیري)، (ترجیح: برتري) () 4  ) (متلاطم: آشفته)، (ازدحام: شلوغی) 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 ، تاب، قهر، حکمت) به ترتیب در کدام گزینه آمده است؟ تمعنی درست واژگان (مذلّ -2

)www.iranestekhdam.ir ( 

 سستی، پایداري، خشمگین، دانایی  )2   ) خواري، فروغ، چیره، معرفت1

 ) زبونی، توانایی، غضب، سعادت4  ) فرومایگی، طاقت، چیرگی، دانش 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 .خورد در همه ابیات به جز بیت گزینه .......... واژگان مترادف به چشم می  -3

)www.iranestekhdam.ir ( 

 خوف و رعب آمد به جاي عقل و هوش   ) بسته شد عزم ملک را چشم و گوش  1

 دل گرانی مکن اي جسم که جان باز آمد  ) مژدگانی بده اي نفس که سختی بگذشت2

 چو کرکس بوي مرداري نخواهم   ) چو بازان ساعد سلطان گزیدم  3

 اي از حسرت گلزار مرا بس بود ناله   ) گو مبر جانب گلشن، قفسم را صیاد   4

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(در کدام گروه کلمه (غلط املایی) یافت می شود؟  -4

 ) استیصال و درماندگی، بزم و ضیافت، قسیم و صاحب جمال1

 ) سفله و فرومایه، عصاره و شیره، ضجه و شیون 2

 ) ضماد و مرهم، بحبوحه و میانه، مطاع و فرمانروا 3



 

 
  

7 

 ) مفرح و شادي بخش، فاحش و واضح، صریر و اورنگ 4

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(در متن زیر چند غلط املایی وجود دارد؟   -5

حوادث به عاقل محیط شود باید که در پناه صواب رود و بر خطا اسرار ننماید و آن را ثبات عزم    «هرگاه 

و حسن عهد نام نکند و اگر خار در چشم مستبد افتد در بیرون آوردن آن غفلت ورزد و آن را خار دارد 

شبهت کور شود. و بر خردمندي واجب است که به غزاهاي آسمانی ایمان آرد و جانب دوراندیشی  و بی 

 » .را مهمل نگذارد 

 دو  )2      ) یک 1

 چهار )4      سه  )3

 4گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  ........... .   به جز  مفهوم عبارت زیر با همه ابیات تناسب مفهومی دارد،   -6

«حالی صواب آن باشد که جمله به طریق تعاون قوتی کنید تا دام از جاي برگیریم که رهایش ما در آن  

 » .است 

 شیر ژیان را بدرانند پوست     ) مورچگان را چو بود اتفاق  1

 چه بود خرابگلستان گردد آن    ) آب را چون مدد بود هم از آب  2

 به تنها و یارانم اندر کمند    بند  ز ) مروت نبینم رهایی 3

 هزار طعنه دشمن به نیم جو نخرند  اند در همه کار  ) دو دوست با هم اگر یکدل 4

 3گزینه پاسخ کارشناس ایران استخدام: 
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 ) www.iranestekhdam.ir( ......... .   به جزهمه ابیات با بیت زیر قرابت مفهومی دارد؛  -7

 اول اندیشه کند مرد که عاقل باشد»   «سخن گفته دگر باز نیاید به دهن  

 روان سراینده رامش برد    سخن چون برابر شود با خرد   )1

 چو ناباور افتد نماید دروغ    ) سخن گر چو گوهر برآرد فروغ  2

 چو رنجش نخواهی سخن را بسنج  ) بدان کز زبان است مردم به رنج  3

 روي به هر کس نوازنده و تازه     ) سخن پیش فرهنگیان سخته گوي  4

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( است؟ متفاوتپیام نهایی کدام بیت با سایر ابیات  -8

 غنیمت دار در این وحشت سرا جمعیت خود را   باشد می به اندك زوري از هم تار و پود جسم  )1

 که عمرم بگذرد ایام گل در آشیان بستن  نیستم بلبل   ، شمارم صحبت گل) غنیمت می 2

 رخشی است که همچو برق در تاختن است  ) از دست منه عنان فرصت که حیات  3

 ماند اي فرصت نمی که تا بر خویشتن جنبیده  ) به دام دوربینی صید کن این برق جولان را  4

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( است؟ نرفتههاي نگارشی به درستی به کار در کدام گزینه نشانه  -9

 ه.ق) است.   1344 –1281نیشابوري ( ادیب) از شعراي دیگر این عصر 1

 به خیر.  -  ترین چهره تاریخ آن شرکت استکه محبوب   - ) یاد مرحوم مهندس نادري 2

 هاي آموزشی براي همه کارکنان ضروري است.» گوید: «گذراندن دوره هاي انسانی می ) مدیر امور سرمایه 3

 ) سازمان، نیازمند مدیریتی قوي و شایسته است؛ نگذاریم گرفتار دیوان سالاري اداري شود.4

 4گزینه پاسخ کارشناس ایران استخدام: 
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 ) www.iranestekhdam.ir(  در کدام گزینه شیوه نگارش تمامی کلمات درست است؟ -10

 پیشامد  - لاخ سنگ  -عالی ) جناب 2  بهوش (هوشیار)  -یکشنبه    -مند ) علاقه 1

 ربط ذي - دار جان  -قدس آستان ) 4   بیسواد –همنام   - متر ) میلی 3

 2گزینه پاسخ کارشناس ایران استخدام: 



 

 

 
 

 

 

 

 

 

 

 :  دومبخش 
 

هوش و استعداد تحصیلی
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 کدام شکل به جاي علامت سوال قرار بگیرد تا سري شکل زیر کامل گردد؟ -11

)www.iranestekhdam.ir ( 

1(      2( 

3(      4( 
 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 

سسه خیریه باید تیمی از داوطلبان را براي تحقیق به مناطق کم برخوردار ارسال کند. او شش  و یک م

او   حداقل دو داوطلب را به    خواهد می داوطلب در اختیار دارد: مالک، زهرا، جواد، کاوه، سایه و بهار. 

این شرایط باید در   شهر بفرستد و در عین حال همواره حداقل دو داوطلب را در دفتر خیریه نگه دارد. 

 انتخاب تیم داوطلبان رعایت شود: 

 ماند.الف) اگر مالک براي تحقیق برود، زهرا در دفتر خیریه می 

 رود. ب) اگر زهرا براي تحقیق برود، جواد نیز می 

 ماند.ج) اگر زهرا در دفتر خیریه بماند، سایه نیز در آنجا می

 توانند هر دو بروند یا هر دو بمانند. د) جواد و کاوه نمی 

توانند با یا بدون همراهی داوطلبان دیگر با هم براي تحقیق  کدام یک از جفت داوطلبان زیر می   -12

 ) www.iranestekhdam.ir(  بروند؟

 ) مالک و سایه 2     ) زهرا و کاوه 1

 ) زهرا و بهار4     ) کاوه و جواد 3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

را در پاسخنامه علامت    15تا    12هاي  راهنمایی: اطلاعات زیر را بخوانید و با توجه به آن، پاسخ سوال 

 بزنید. 
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تواند فهرست کامل داوطلبانی باشد که در  اگر زهرا براي تحقیق برود، کدام یک از موارد زیر می   -13

 ) www.iranestekhdam.ir( مانند؟دفتر می

 ) کاوه و مالک 2    ) جواد، مالک و سایه 1

 ) بهار، جواد، مالک و سایه 4     ) بهار، جواد 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 مانند؟ فهرست کامل داوطلبانی باشد که در دفتر می تواندنمی کدام یک از موارد زیر  -14

)www.iranestekhdam.ir ( 

 ) بهار، کاوه، سایه و زهرا 2    ) کاوه، سایه و زهرا 1

 مالک و سایه  ، ) بهار، کاوه4    ) بهار، کاوه و زهرا 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

گزینه  -15 از  یک  کدام  باشند،  داشته  را  وظیفه  یک  مالک  و  سایه  از اگر  معتبري  انتخاب  زیر  هاي 

 ) www.iranestekhdam.ir(  بزرگترین تیم ممکن براي تحقیق است؟

 ) بهار، جواد و زهرا 2    ) بهار، مالک و سایه 1

 ) مالک، سایه، زهرا و کاوه 4    ) بهار، جواد، کاوه و زهرا 3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

هاي پارچه را براي پیراهن تهیه کند. او هر رول با طول  هایی از رول خواهد تکه پارچه یک خیاط می   -16

دقیقه چند رول    24برش در دقیقه است. در    45و سرعت برش او    دهدتکه برش می  10مساوي را به  

 ) www.iranestekhdam.ir(  شود؟بریده می

1 (120      2 (108 

3 (54      4 (32 

 1گزینه پاسخ کارشناس ایران استخدام: 
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از    -17 با شروع  را  از  شماره گذاري می  1یک چاپگر صفحات یک کتاب  و در مجموع  رقم   192کند 

 ) www.iranestekhdam.ir(  کند. این کتاب چند صفحه دارد؟استفاده می 

1 (84      2 (92 

3 (100      4 (120 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

ساعت به    6کند و در عرض  کیلومتر بر ساعت دوچرخه سواري می   30سورنا با سرعت متوسط   -18

  10کند. اگر سورنا سرعت متوسط خود را  ساعت طی می   4مهران همین مسافت را در    . رسدمقصد می 

را   متوسط خود  مهران سرعت  و  بر ساعت  زمان    5کیلومتر  تفاوت  دهد،  افزایش  بر ساعت  کیلومتر 

 ) www.iranestekhdam.ir(  رسیدن آنها به مقصد چقدر خواهد بود؟

 دقیقه   42) 2     دقیقه   40) 1

 دقیقه   60) 4     دقیقه   54) 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

نیم   -19 کاسه  داخلی  کره یک  شعاع  به  ظرف    مترسانتی  12اي  در  باید  مایع  این  است.  مایع  حاوي 

متر ریخته شود. تعداد ظروف لازم براي خالی کردن سانتی   3سانتی متر و ارتفاع    4اي به قطر  استوانه 

 ) www.iranestekhdam.ir( کاسه برابر است با .......... .

1 (80      2 (86 

3 (96      4 (106 

 3گزینه پاسخ کارشناس ایران استخدام: 
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هزار تومان   200میلیون و    1هزارتومان براي خرید چند میز به قیمت هر کدام    100میلیون و    8فردي    -20

ها به تعداد میزها  . نسبت تعداد صندلی کندمی هزارتومان هزینه    300و چند صندلی به قیمت هر کدام  

 یز خریداري شده باشد، برابر است با .......... .مدر حالتی که حداکثر تعداد ممکن 

)www.iranestekhdam.ir ( 

 2به  1) 2     1به  1) 1

 7به  5) 4     1به  2) 3

 2گزینه پاسخ کارشناس ایران استخدام: 



 

 

 
 

 

 

 

 

 

 

 :  سومبخش 
 

کامپیوتر 
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، و ... نمایش داده  2-1،  1-1به صورتی که مثلا    گذاري خودکار در تیترهابراي شماره    Wordدر  -21

 ) www.iranestekhdam.ir( شوند باید از کدام بخش استفاده کرد؟

1  (Bullets and Numbering  2 (Multilevel List 

3(Outline view     4(Caption  

 2گزینه پاسخ کارشناس ایران استخدام: 

 در کدام سربرگ قرار دارد؟  Spelling & Grammar، ابزار wordدر نرم افزار  -22

)www.iranestekhdam.ir ( 

1 (Home     2(insert 

3(Review     4 (Layout 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

براي اینکه یک متن با پاراگراف به طور کامل در یک صفحه باقی بماند و به صفحه منقل    Wordدر  -23

 ) www.iranestekhdam.ir(  نشود، باید از کدام گزینه استفاده کنیم؟

1  (Insert → Page Break 

2  (퐻표푚푒 → Paragraph → Keep Lines Together 

3  (퐿푎푦표푢푡 → Columns  

4  (References → Cross Reference  

 2گزینه پاسخ کارشناس ایران استخدام: 
 

براي اینکه در یک خانه اعداد به صورت درصد نمایش داده شود، آن را از چه نوعی    Excelدر   -24

 ) www.iranestekhdam.ir(  کنیم؟تعریف می 

1 (Percentage    2(Fraction  

3 (Currency     4(Scientific  
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 1گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  فرمول روبه رو در اکسل کدام گزینه است؟ زانتیجه حاصل   -25

푫 = 2^3 ∗ 2 + 4 2⁄  

1 (144      2 (66 

3 (10      4 (18 

 4گزینه پاسخ کارشناس ایران استخدام: 

 

به طوري که هنگام اسکرول کردن همیشه دیده شوند، از چه    هاستون یا  ها  براي قفل کردن ردیف  -26

 ) www.iranestekhdam.ir( کنیم؟اي استفاده می گزینه 

1  (View → Freeze Panes 

2  (Data → Sort 

3  (Review → Protect Sheet 

4  (퐼푛푠푒푟푡 → 푇푎푏푙푒 

 1گزینه پاسخ کارشناس ایران استخدام: 
 

 چیست؟   Accountingو  Numberتفاوت بین فرمت   Excelدر  -27

)www.iranestekhdam.ir ( 

1  (Number کند ولی  بندي می فقط متن را قالبAccounting  .مخصوص تاریخ است 

2  (Number    و معمولی  اعداد  استفاده    Accountingبراي  مناسب  ترازبندي  با  پولی  مقادیر  نمایش  براي 

 شود.می 

3  (Number  به طور پیش فرض اعشار ندارد ولیAccounting   .دارد 

 ) هیچ تفاوتی ندارند.4
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 2گزینه پاسخ کارشناس ایران استخدام: 
 

 ) کدام کلیدها درست است؟ Stop) و توقف گذاري (Refreshبراي بارگذاري مجدد صفحه ( -28

)www.iranestekhdam.ir ( 

1( F 5 → Refresh, Esc → Stop 

2  (Ctrl + R → Stop, F 5 → Refresh 

3  (F 12 → Refresh, Esc → Stop 

4  (F 5 → Stop, Ctrl + S → Refresh 

 1گزینه پاسخ کارشناس ایران استخدام: 
 

 دهد؟ چه چیزي را نمایش می 퐈퐧퐭퐞퐫퐧퐞퐭 퐄퐱퐩퐥퐨퐫퐞퐫در پایین  (푺풕풂풕풖풔 푩풂풓)نوار وضعیت   -29

)www.iranestekhdam.ir ( 

 ) وضعیت بارگذاري صفحه و لینک مقصد 2    ) آدرس صفحه فعلی 1

 ) تنظیمات امنیتی Favorites     4 ) لیست 3

 2گزینه پاسخ کارشناس ایران استخدام: 
 

 براي حذف یک برنامه به صورت کامل از ویندوز، از کدام بخش باید اقدام کرد؟ -30

)www.iranestekhdam.ir ( 

1  (File Explorer  

2  (Control panel → Programs and Features 

3  (Task Manager → Startup 

4  (Run → temp 

 2گزینه پاسخ کارشناس ایران استخدام: 



 

 

 

 
 

 

 

 

 

 

 

 :  چهارمبخش 
 

آشنایی با مفاهیم پولی و بانکی
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  ها مکلفند براي ارائه دسته چک به مشتریان خود صرفا از طریق سامانه ............ اقدام نمایند.بانک   -31

)www.iranestekhdam.ir ( 

 ) پایا2      ) صیاد 1

 ) چکاد 4     ) چکاوك 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

  عنوان وسیله ............ استفاده کرد. چک فقط وسیله ............ است و نباید از آن به  -32

)www.iranestekhdam.ir ( 

 پرداخت  - دریافت ) 2    اعتبار  -پرداخت ) 1

 پرداخت  - اعتبار ) 4    اعتبار  - دریافت ) 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

شفاف   -33 دستورالعمل  تراکنش براساس  روزانه  سازي  انتقال  جهت  اعتباري  موسسه  بانکی،  هاي 

شده براي «مشتري حقیقی» و «مشتري حقوقی» کدام تشابه و  الکترونیکی وجوه بیش از سقف تعیین 

 ) www.iranestekhdam.ir(تفاوت را باید رعایت کند؟ 

 کدام الزامی نیست.براي هیچ ) 1

 فقط مشتري حقیقی نیازمند اسناد مثبته است. ) 2

 تنها براي مشتري حقوقی تکمیل فیلد «بابت» الزامی است.) 3

  10میلیارد و حقوقی    4سقف مشتري حقیقی    - هر دو نیازمند تکمیل فیلد «بابت» و ارائه اسناد مثبته هستند  )  4

 میلیارد ریال است.

 4گزینه پاسخ کارشناس ایران استخدام: 

 

تواند حساب خود را به علت  قانون چک، شخص دارنده چک تا چه مدتی می   14براساس ماده    -34

سرقت یا مفقودي نزد بانک توقیف نماید و پس از آن باید گواهی تقدیم شکایت نزد مقام قضایی را  

 ) www.iranestekhdam.ir( براي بانک بیاورد؟ 

 ده روز ) 2     یک هفته ) 1
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 یک ماه ) 4     دو هفته ) 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

هاي اعتباري / اقساطی بانک رفاه کارگران به مشتریان، چه نام دارد؟ پلتفرم آنلاین طرح  -35

)www.iranestekhdam.ir ( 

 پیوند ) 2      بتا ) 1

 شهاب) 4     همبانک رفاه ) 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 گویند. ............  مطالباتی که از شش ماه تا هجده ماه از سررسید آنان سپري شده باشد را مطالبات    - 36

)www.iranestekhdam.ir ( 

 ) سررسید گذشته 2     ) جاري 1

 الوصول ) مشکوك 4     ) معوق 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

ماه از تاریخ صدور چک براي وصول آن به بانک مراجعه نکند ............  که دارنده چک تا  در صورتی   -37

کیفري  ............  یا ظرف   ننماید، دیگر حق شکایت  پرداخت شکایت  تاریخ صدور گواهی عدم  از  ماه 

 ) www.iranestekhdam.ir( نخواهد داشت. 

 شش ماه  - ) سه ماه 2    شش ماه  -  ) شش ماه1

 سی روز  - ) سی روز 4    یک ماه  - ) یک ماه 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

  اشاره دارد؟ "حق برداشت فوري وجه از حساب بانکی"کدام مفهوم در بانکداري به  -38

)www.iranestekhdam.ir ( 

 ) سفته 2    دار ) سپرده مدت1
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 ) سپرده جاري (دیداري) 4     ) اعتبار اسنادي 3

 4گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(   باشد؟زیر کمترین ریسک را دارا می   هايگذاري یک از سرمایه کدام   -39

 گذاري مشترك هاي سرمایه ) صندوق 2    ) اوراق قرضه دولتی 1

 ) اوراق سهام پذیرفته شده در بورس 4    ) اوراق قرضه شرکتی  3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

   کدام مفهوم به تعداد دفعات استفاده از یک واحد پولی در مدت زمان مشخص اشاره دارد؟ -40

)www.iranestekhdam.ir ( 

 ) پایه پولی 2     ) نقدینگی1

 ) سرعت گردش پول 4     ) حجم پول 3

 4گزینه پاسخ کارشناس ایران استخدام: 



 

 

 
 

 

 

 

 

 

 

 :  پنجمبخش 
 

زبان انگلیسی عمومی
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41- Will you ............ that John when you see him, please? 

(www.iranestekhdam.ir ) 

1) ÇÉÖÉÎÇ     2) ÂÅ ÇÏÉÎÇ ÔÏ ÇÉÖÅ 

3) ÇÉÖÅ     4) ÔÏ ÇÉÖÅ 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

42- That comedy was ............ all the other movies I've ever watched. 

(www.iranestekhdam.ir ) 

1) ÔÈÅ ÆÕÎÎÉÅÓÔ    2) ÆÕÎÎÉÅÒ 

3) ÁÓ ÆÕÎÎÙ     4) ÆÕÎÎÉÅÒ ÔÈÁÎ 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

43- The new university was built to be the top choice for international students 

…………… to study in the city. (www.iranestekhdam.ir ) 

1) ÉÎÓÔÁÌÌÉÎÇ     2) ÁÔÔÅÎÄÉÎÇ  

3) ÇÒÁÄÕÁÔÉÎÇ    4) ÈÏÐÉÎÇ 

 4گزینه پاسخ کارشناس ایران استخدام: 

 

44- They have enough power to  …………… themselves from those who would hurt 

them.  (www.iranestekhdam.ir ) 

1) ÉÎÔÅÒÖÉÅ×     2) ÄÅÆÅÎÄ 

3) ÒÅÃÈÁÒÇÅ     4) ÃÏÎÔÒÁÃÔ 

 2گزینه پاسخ کارشناس ایران استخدام: 
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45- My brother is studying photography in Tehran University. He always …………… 

a camera with him wherever he goes. (www.iranestekhdam.ir) 

1) ÎÅÅÄÓ     2) ÄÏÎÁÔÅÓ 

3) ÃÁÒÒÉÅÓ     4) ÄÅÓÃÒÉÂÅÓ 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

Close Test: 

Banks play a crucial role in the economy by providing financial services to 

individuals and businesses. One of their main functions is to accept deposits from 

customers, which can then be used to  ...   )46( ... loans to borrowers. Customers 

earn  ... )47 (  ... on their deposits, which encourages saving. Central banks, unlike 

commercial banks, are responsible for regulating the money supply and 

controlling inflation, and they implement monetary ... )48(  ... to maintain 

economic stability. Modern banking also offers electronic services, allowing 

customers to perform transactions online or via mobile apps, which  ... )49(  ... the 

efficiency of financial operations. Finally, effective risk management is essential, 

as banks must evaluate borrowers’ creditworthiness to ... )50(  ... the possibility of 

loan  defaults. 

46- (www.iranestekhdam.ir ) 

1) ÃÏÌÌÅÃÔ     2) ÇÒÁÎÔ 

3) ÒÅÆÕÓÅ     4) ÄÅÐÏÓÉÔ 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

47- (www.iranestekhdam.ir ) 

1) ÆÅÅÓ     2) ÐÅÎÁÌÔÉÅÓ  

3) ÆÉÎÅÓ     4) ÉÎÔÅÒÅÓÔ 
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 4گزینه پاسخ کارشناس ایران استخدام: 

 

48- (www.iranestekhdam.ir ) 

1) ÐÏÌÉÃÉÅÓ     2) ÄÅÐÏÓÉÔÓ 

3) ×ÉÔÈÄÒÁ×ÁÌÓ    4) ÔÒÁÎÓÆÅÒÓ 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

49-  (www.iranestekhdam.ir ) 

1) ÉÎÃÒÅÁÓÅÓ     2) ÄÅÃÒÅÁÓÅÓ 

3) ÉÇÎÏÒÅÓ     4) ÅÌÉÍÉÎÁÔÅÓ 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

50- (www.iranestekhdam.ir ) 

1) ÉÎÃÒÅÁÓÅ     2) ÉÇÎÏÒÅ 

3) ÍÉÎÉÍÉÚÅ     4) ÃÅÌÅÂÒÁÔÅ 

 3گزینه پاسخ کارشناس ایران استخدام: 



 

 

 

 

 

 

 

 

 

 

 »محصولات مرتبط دانلودي  «
   یاستخدام  يهادر آزمون  یآمادگ يبراهاي آموزشی دانلود درسنامه

 خرید و دانلود 

 

 

 »محصولات مرتبط چاپ شده  «
 استخدامی هاي هاي چاپ شده براي آمادگی در آزمون سفارش کتاب 

 خرید و سفارش 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D8%AF%D8%B1%D8%B3%D9%86%D8%A7%D9%85%D9%87-%D9%87%D8%A7%DB%8C-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C
https://ketab.iranestekhdam.ir/


 

 

 

 
 
 
 
 

 
 
 

 

 

 

 

 

 
 

 سرویس خصوصی خدمات عام المنفعه اخبار شغل و استخدام 

Www.IranEstekhdam.Ir 

 

   خود در مورد مطالب آن شنهادیلطفاً هرگونه انتقاد و پ فایل؛  نیا تیفیدر جهت بهبود ک  ؛یخواننده گرام

 : دیینما مطرح  ر یزو یا با شماره تلفن   لیمی اآدرس گزارش مشکل را به یا و 

    soal@iranestekhdam.irآدرس ایمیل:                       021- 91300113شماره تلفن تماس:  

 

http://www.iranestekhdam.ir/

